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We thank you for being a user of Integra for Notes, the tools offering advanced reporting and bi-
directional data integration between Lotus Notes™ and Microsoft Word™ and Excel™.

This manual is designed to assist end-users of Integra for Notes who are generating reports, importing
data or integrating with Microsoft Word and Excel. The process of defining reports, exports and imports is
handled by a dedicated manual entitled the Integra for Notes Designer’s Manual. Separate manuals are
also available covering installation and configuration as well as upgrading from one version of Integra for
Notes to another. All  these manuals can be found on-line in PDF format at
www.integra4notes.com/manuals.

In addition, Integra Quick Reports is a companion product to Integra for Notes which is aimed at allowing
end-users to create and run their own ad-hoc reports to Excel as well as generating mail merge letters
and labels from Notes databases. Separate documentation is also available for this product on the
manuals web page listed above.

These materials are copyrighted and the intellectual property rights are vested in Shireburn Software Ltd.
Copying through any means is unauthorized without the express written permission of an officer of
Shireburn Software Ltd.

Every reasonable attempt has been made to ensure the accuracy of this user manual and that it reflects
the operations of the product, however users of Integra for Notes are responsible for ensuring that the
product and its documentation are suitable for the needs of that organization. No warranties in respect of
this user manual are being made or can be assumed.

The product Integra for Notes may at times be referred to within this documentation by its shortened
name of Integra. These products are not to be confused with any trademarked product that may exist
with a similar name, whose rights are hereby recognized, and this is used only for ease of reference.

© Shireburn Software Ltd 2006-2009

Lotus, Lotus Notes, Domino and their respective logos as well as the IBM Business Partner logo are all registered trademarks of
IBM Corporation. Microsoft, Windows, Word, Excel and Internet Explorer as well as their respective logos are all trademarks of
Microsoft Corporation. Acrobat Writer, Acrobat Distiller and PDF are registered trademarks of Adobe Corp. All other trademarks are
hereby duly acknowledged as the property of their respective owners.
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About Shireburn Software

Shireburn Software Ltd is the author and distributor of the Integra family of products. The company is an
IT Services company specializing in the development and implementation of collaborative solutions based
on the Lotus Domino and Lotus Notes environments as well as other systems for financial and inventory
management.

Established in 1983, the company has been active in the field of Lotus Notes development since 1993
and has considerable experience in the range of skills required covering business analysis, consultancy,
creation of functional specifications, design, development, implementation and on-going support of such
solutions.

Shireburn Software was a founding member of the Lotus Key Partner program in 1990,
which then transitioned into the Lotus Business Partner program, where Shireburn was
an Advanced member until the program was merged with the IBM PartnerWorld for
Software program in which Shireburn is an active member. Shireburn is an IBM
Advanced Business Partner.

Shireburn Software Ltd has won various awards for its Integra range of products including:

Editors Choice Award by Lotus Advisor Magazine in 2007 Lotus.
Editors Choice Award by Lotus Advisor Magazine in 2006
Editqrs Choice Silver Award by Lotus Advisor Magazine in the Business L01:|US.
Intelligence Category in 2005 [ADVISOR XL
Winner of the e-Pro Magazine Apex Award in the Portals and Content Management EDITORS' CHOICE 2006
category in 2004 Lot_u&
Finalist in the e-Pro Magazine Apex Award within the Reporting in 2003 ET I TILEFT)

2004

APEX ..

AWARDS Lotus

SHIREBURN

Carolina Court, Guze Cali Street
Ta’' Xbiex, XBX 1425, Malta
Tel US (508) 915 4805 or (650) 276 0506
Tel UK (020) 7193 1296
Tel EU (+356) 2131 9977
Fax (+356) 2131 9528

info@shireburn.com
www.shireburn.com

www.integra4notes.com
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About this Manual

This user manual is aimed at the end-user of Integra for Notes who is running Integra for Notes to
generate reports that have already been created by a user of Integra for Notes.

This manual is divided into the following main sections:

An introduction to Integra for Notes for the end-user
Running Integra Profiles through a Lotus Notes Client
Running Integra Profiles through a Web Browser

Two companion manuals in the Integra series exist:

Integra for Notes Designer’s Manual — this manual guides the reader through the process of
creating profiles in Integra for Notes

Integra Installation & Configuration Manual — this manual guides the reader through the process
necessary for the installation and deployment of Integra for Notes

All these manuals are available at www.integra4notes.com/manuals.

Conventions used within this Manual

This user manual is designed to be a guide to Entegra_
the functionality of Integra for Notes as available 28 WEvEs
to the end-user. The keys required to be Document Tite: [PassportEnrolment Form

selected by a user are explained within this

Run on: * Cient  Server
manual by the use of angled brackets. i _
Therefore, an instruction to select the key called g El
Enter will appear as follows: select <Enter> TEDAET i

Open / Save As PDF: Mo =
Prompts given to the user to allow selection of Protection: T

one or more options are shown in a dialog box
as shown alongside:

Password: | |

Hot tips of particular interest to readers are —

displayed as follows:

If your profile has had its confidentiality restricted, only those users mentioned
d in the profile’s confidentiality field will be able to see the profile.

Bright ideas and recommendations are shown within the following type of display:

F o To create a profile document linking to a particular database, the user does
not require Designer rights in the Access Control List of the database to
]'J which the link is being implemented but rather just Reader level rights.
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1 Introduction to Integra for Notes for the End-User

Integra for Notes provides the capability to:

generate reports on data held in Lotus Notes databases. The process generates these reports into

Microsoft Excel & Word files, XML and PDF files leveraging the power of these environments to utilize

features such as graphic, pivot tables, data filtering etc.

integrate Lotus Notes data with Microsoft Word and Excel.

import data held in Microsoft Excel, Text files or complete Word files into Lotus Notes documents.
Integra for Notes allows authorized users to create Integra Profiles. An Integra Profile is a normal Notes
document within the Integra Lotus Notes database which defines the fields being imported or exported,
the layout of the Word or Excel template, and settings such as filtering conditions, output options etc.
related to a particular import or export process.
Integra profiles can be executed in a number of ways including:

manually by an end-user clicking on the Integra Smarticon while in a particular Lotus Notes O

database (other than the Integra database) which generates a dialog box listing all the profiles

linked to that database that the user is currently in.

manually by an end-user clicking on an action button or hotspot in an application

automatically according to a timed schedule.
Once an Integra profile is run, the data can be:

presented on screen in Word, Excel or Adobe Acrobat Reader

e-mailed out to intended recipients, the e-mail addresses of which can be defined in the profile or

computed at runtime according to a formal

printed

saved to a Notes document

saved to a file on the local hard disk or a network drive

combinations of the above
While the process of creating profiles in Integra for Notes is covered by a separate manual (Integra for
Notes Designer’s Manual), this Integra for Notes end-user manual explains how pre-defined import and
export profiles can be run by the end user.
Integra Quick Reports, a companion product within the same Integra family of products, provides facilities
for end-users to create and run ad-hoc reports to Excel as well as mail merges and labels via Microsoft
Word. While Integra for Notes is able to deal with more advanced reporting and data integration needs,
Integra Quick Reports is very simple and aimed directly at self-service by the end-user. Read about
creating and running Integra Quick Reports in the user manual entitled Integra Quick Reports — User
Manual also found at www.integra4notes.com/manuals.
The following subsequent sections are contained in this user manual:

Section 2 - Running Integra Profiles through a Lotus Notes Client

Section 3 - Running Integra Profiles through a Web Browser

Integra for Notes 4.7 — End-User Manual V4.7/1.0 1
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2 Running Integra Profiles through a Lotus Notes Client

The use of profiles in Integra for Notes is designed to be very simple. Because profiles are normally
created to link a specific Notes database with a Word, Excel or Text file, either for Import or Export,
Integra is actually accessed from the source database from which or into which the data is to be
accessed.

With ease of use heavily in mind when creating Integra, especially for the end user of the profiles, all the
user needs to do to run an Integra profile from a Lotus Notes Client, is to:

Open the Lotus Notes database from which the data is to be exported or into which it is to be
imported

Select the appropriate view (unless the profile is already linked automatically to a specific view — see
later explanation of profiles)

Select the appropriate documents to be reported on by dragging the mouse down the selection
column in the view as per standard Notes client procedures (unless the profile is already linked
automatically to a specific formula — see later explanation of profiles) @ Time Sheets Demonsiration - Date - IBM Lotus

File Edit View Create Actions Tools

Either click on the Integra for Notes icon in the Smartlcons bar or =
select an Action Button or Hotspot which is linked to a specific O S ™ e Shoets Deme
Integra profile. See a later explanation about linking Action Buttons to
Integra profiles.

- dabDaiauts i tLingual o '----)

This explanation assumes that the Integra for Notes product has been

4 installed and configured for use within your organisation in accordance
with the instructions contained in the Integra Installation & Configuration
Manual.

If the user’s Notes preferences are set not to display Smarticons or Toolbars (see the Smartlcons
displayed below), this can be modified through the menu option called File-Preferences-Toolbar
Preferences.

In the event that the user does not have a minimum of Author rights to the Integra database, the system
will advise the user by means of the following message:

‘t'ou have insulficient rights ta the Integra for Motes database. You need at least Authar rights. Please contact your
adrministratar.

A developer may want to further automate the process through which an end-user runs a particular
Integra profile and rather than requiring the end-user to select the documents and then click on the
Integra Smartlcon, a standard Lotus Notes Action Button or Hotspot could be made available on a
particular Notes view or form which executes a pre-named Integra profile. This will allow the user to
select the Action Button and Integra will execute the profile without providing a list of available profiles to
be executed to the user. This method is required in the case of a user making use of a Web Browser as
Smartlcons are not supported by the Web Browser.

This procedure allows a greater level of integration between a specific Notes application and the Integra
environment. Details of how to set up such an Action Button in an application to call Integra for Notes are
contained in the Integra for Notes Designer’s Manual.

Integra for Notes 4.7 — End-User Manual V4.7/1.0 2
Shireburn Software Ltd - © 2009 — 5" January 2009
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2.1 Profile List Dialog

On selection of the Integra for Notes Smartlcon, Integra for Notes will present the user with a dialog

box to select the particular profile required.

O

The profiles displayed here will be those
profiles created in the Integra database

integra

for notes

which are linked either to the currently R
selected Lotus Notes database or to a % ExponView To Excel- New Sheet per Category A
deS|gn template that is used by the w® 1 Export View To Excel - New Sheet per Categary (FLAT)
current Notes database. quoies _
® = Quotation
. . . . , ¥ Reports
Profiles will be displayed by the profiles %= Analysis Excelwith doclinks V.1
Runtime Category (a field contained on i Analysis Excelwith doclinks V.2
the profile). The dialog box title will L L LR
€ profl e)'. € dialog box title wi =® Sample export from a live and archive database

reflect the title of the source Notes % Time Sheet- Export raw data
database from which the data will be = limelsheetAnalystwiEookup

for inst th | oy Time Sheets Prompt User
aCCGSS.ed, orins ancel € example = 21 Time Sheets with Runtime Dialogs i
alongside shows the dialog box executed = T o s
from the Time Sheets database, with the 00 Q

name at the top right side of the dialog
box.

—

Profiles may contain a series of icons alongside them indicating features of the profile, these icons are

described in the table below:

Ilcon Description
®  Generates a profile using Microsoft Word
g2 Generates a profile using Microsoft Excel
##  |dentifies saved report created using Integra Quick Reports
=] Output is set to be e-mailed out.
=  Output is set to be stored to a file.
=2 Indicates that runtime dialog boxes will be displayed on execution

As will be further described in the Integra for Notes Designer’s Manual, the Integra Profile contains a
Reader Names field called Confidentiality which can be used to make available specific reports only to
particular users, groups or roles. The user running Integra will only be presented within the dialog box

with a list of those profiles to which he has access.

When the dialog is displayed, by default all available profiles are categorized by type. By clicking the little
marrow at the right side of the top bar, the order can be changed between categorized by type and sorted

by profile name.

Select a profile from the list and click on the OK button to run the chosen profile.
Click on the Cancel button to abort Integra and to return to the current database.

O

Integra for Notes 4.7 — End-User Manual V4.7/1.0
Shireburn Software Ltd - © 2009 — 5" January 2009
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2.1.1 Running Integra Quick Reports

Since an organization may deploy both Integra for Notes as well as the Integra
Quick Reports product, rather than having two user interfaces for users to
manage, when both products are in use reports created using Integra for Notes or

saved reports created using Integra Quick Reports will appear in the list of available reports in the dialog
box above.

In addition to running one of the reports already created and listed in the profile dialog box, the user can
also select the Quick Reports button, which will launch the Integra Quick Reports product providing the
user with an ability to generate their own Excel based reports or Word based mail merges and labels from
the current Lotus Notes view using a simple 4 step wizard. Further details about using Integra Quick
Reports are found in Integra Quick Reports User Manual. In the event that an organization does not have
a license for Integra Quick Reports, selecting the Quick Reports button will provide them with a message
to this effect (see below).

Integra Error Message

1 This Integra for Motes database is not licensed for Quick Reports. Please contact support@integra4notes.com to ask for the required licence.,
LY

2.1.2 Editing an Existing Profile

The Edit button allows authorized users to edit a profile listed in the profile list dialog. Users
able to edit profiles at runtime need to be allocated the [RuntimeEdit] role. In addition, to edit

an Integra for Notes profile a user must have either Editor rights or above to the Integra for Notes
database or be included in the Profile Editors field on the Integra profile.

If a profile is selected which was created using Integra for Notes, then on editing the profile, the user will
be presented with the profile directly inside the Integra for Notes database and all the standard facilities
available for profile creation and editing become available to the user. For more details see the Integra
for Notes Designer’s Manual.

If an Integra Quick Report profile is selected in the list when the Edit button is used, then the report is
loaded into the Quick Reports wizard to allow modification of the report. For more details about the
options available in Integra Quick Reports please refer to the Integra Quick Reports User Manual.

2.2 Sorting & Grouping Dialog

An option was introduced into Integra for Notes in version 4.5 that allows a profile to be set to enable an
end-user to select sorting and grouping options related to the report being generated at the time of
running this report. This facility delegates the sorting and grouping options to end-users allowing a
generic profile to be created to meet the needs of various sorting and grouping options.

For the sake of clarity, grouping is the facility of Excel to display data categorized by a grouping field
including totals, averages, counts etc related to the chosen field. Excel supports three hierarchical levels
of grouping and these are available directly from the Integra Sorting & Grouping dialog.

An Integra profile is set to display the Runtime Sorting & Grouping dialog by a licensed user of the Integra
for Notes Designer Edition and this is done in the Filtering & Sorting tab of the Integra profile. Refer to
the Integra for Notes Designer Manual for further instructions on setting this option.

Integra for Notes 4.7 — End-User Manual V4.7/1.0 4
Shireburn Software Ltd - © 2009 — 5" January 2009
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Profiles which are set to present Integra’s runtime dialog boxes are shown in the Profile Dialog List with a
question mark icon alongside them. 2

When the profile being run by a user is set to e 'miegpra oring & Grousing
display the Runtime Sorting & Grouping dialog the
following dialog box is presented to the user. Sort by Order Group 3]
_ +| ™ Ascending " Descending r
The Sorting & Grouping dialog is intended to | 7]  Ascenang (" Descending r
perform two separate although related tasks: | 7] © Asssndng € Descending r
Sorting — this determines the order in which il e ot
the data is shown in Excel or Word. For & C
instance selecting to sort by the field called =l -
Company will mean that the data in Excel is -
shown in rows sorted alphabetically by the .
contents of the Company column.
. . Pivot Table Fiter Selection (Page Header)
Grouping — this feature (only available when bacedon,
executing an Integra Excel profile but not a 00O

Word profile) invokes Excel’'s Data->Sub-total
command to group data and sub-total
according to a particular criteria such as the Company or Employee columns. Grouping is related to
sorting in that Excel will not allow grouping on data which is not sorted by the same criteria. To group
data by Company requires the data to be sorted by Company.

Sorting

The sorting facility allows the determination of the order of presentation of the reported data in Microsoft
Excel. While additional sorting can be undertaken within the Excel spreadsheet itself, using Excel’s
Data->Sort command, the sorting set within Integra can be selected by the user with great ease.

The use of the sorting facility is optional and, if no sorting is defined, the data will be presented in Excel in
the order in which it is shown in the Notes view.

Integra allows sorting to be undertaken at up to 3 9 integra
levels. As a result, for instance, it may be possible
to report on time sheet data sorted by company oy v S
name with all rows related to the same company | ] © Ascending O Oescending r
then being sorted by date and then by work type.
This recursive sorting capability allows powerful
presentational facilities to the user.

quick reports Sorting & Grouping

¢ Ascending  Descending [

| ¥ Ascending { Descending I

Group by Function Add function to Page

Selection of the fields/columns on which the [ E|| =] | El =
sorting is to operate is undertaken by selecting the | =] 5 =
columns directly in the appropriate fields in the | ;” 1y =
dialog as shown in the circled screenshot = )
alongside.

_|‘C

Pivot Table Fitter Selection (Page Header)
based on:

Q09

The pull-down menu will present the user with a list
of the available fields by which to sort. Select the
sorting order for up to 3 levels of sorting.

Each sorting level can be defined as being in Ascending or Descending order by selecting the appropriate
radio button in the Order section. Sorting defaults to Ascending.

In additional each level can be set to be grouped. This functionality is defined in the section below.

Integra for Notes 4.7 — End-User Manual V4.7/1.0 5
Shireburn Software Ltd - © 2009 — 5" January 2009
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2.2.2 Grouping

The Grouping facility in Integra is only applicable for Excel exports as grouping is not a relevant
functionality for a Microsoft Word profile.

The Grouping facility allows for the automatic presentation in the Excel spreadsheet using Excel’'s Sub-
Total commands. Grouping, which can only be implemented if the data is also sorted in the same order
as it is grouped, will allow the presentation of the data “categorized” under the field on which the data is
grouped allowing collapsing and expanding of data per group in a manner somewhat similar to a Notes
view, and optionally showing totals, averages or counts of the data per group.

{3 Microsoft Excel - Integra.xls

. i3] Fle  Edit Fomst Tooks Data Window Help
The screenshot alongside shows an Excel DG 3 BB 8 Z e B A B
. D3 - A Staff
spreadsheet generated from a time sheets Notes O — - T e N L E——
database which shows data grouped by work type with I — e T
a total per work type. e B oo T | el
" zAdmm\straunn 26/M8/04 Cyberdey Corparation Elenor Caesar Thu 0.17 Document
# LAdmmwstratmn 26/08/04 Securite Famica SA Frank Green Thu 0.25 InfoMedix
You W|” not|Ce the m|nus S|gns |n the Ieft hand marg|n .i/\dmmsuaunn 270804 BgDHGthP Julian Mushy Fri 100 Dac Tracker
X . 3 |10 [Adrinistration 27108/04 | Cyberdav Corparation Leonard Target Fri 1.58 eSecurity
WhICh alIOW Co”apSIng Of the data In that group %‘D\:::::S‘m‘io“ 26/08/04 Securite Famica SA Frank Green Thu g?i InfoMedix
(resulting for instance in presentation as in the screen o 0 S ComirSobiors ™ |Frk T | TSP
shot alongside with collapsed group data. e — e T
lDemns 28/08/04 Fujiyama Trading Limited Charles Masters Sat 0.50 Product Tracker
. ) . L ﬁsz:‘i:n?ml 29/08/04 | Simisi Computer Solutions Charles Masters Sun S:S InfoMedix
Once collapsed, the minus sign shows as aplus sign  |[[: 2owrn Zmbmin amei o Sopgee
to allow expansion again. e — ! i
In addition the 1 2 3 icons shown at the top left of the Excel
spreadsheet (see alongside) allow display of all groups at each level. R e B e ke it
L ) . A : =N NEYIE RN =N - A
All this is standard Excel sub-total functionality which is just triggered BN = A st
by |ntegra ,‘ 2t 1 } = | s ‘ TiIEE Sh
2
3 |work T D [
To group the Excel spreadsheet by the sorted column, select the B risraion [t Fyams ade ke
Group checkbox alongside the field shown circled below. | & [Administration |26/08/4 [BBDH GmbH
B |Administration 26/08/04 Cyberdev Corporation
"7 |Administratinn PRMAMA [ Reririte Famica SA

Once the Group checkbox has been selected, a set of fields will open up allowing setting of the options
related to that group. These typically revolve around the function used for grouping, i.e. Sum, Average,
Count, Min, Max etc as well as the particular field on which the function is to operate. Integra defaults to
the use of the Sum function.

integra
Once grouping is selected, it is mandatory that a auiekrerors Sortig & Grauping
field is selected on which the grouping function is —— order
to Operate ‘COMPANYNAI.‘E ﬂ + Ascending { Descending
‘ j + Agcending (" Descending
If more thgn one grquping level is §elected, these | ] Ascontng € escenan
settings will be required to be applied to all the
|eVe|S Group by Function Add function to ;aii
‘COMPANYNAME [sum - COMPANYNAME AR
STAFFNAME
DATEJOB -
| =] = | =l
| = = E -
Place grouping " abovedata * below data
" Generate Pivot Table " AddcChart
Pivot Table Fiter Selection (Page Header)
based on:
Q0O

Integra for Notes 4.7 — End-User Manual V4.7/1.0 6
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2.2.2.1 Generate Pivot Table

PivotTables are a standard feature of Microsoft Excel
that enable very sophisticated analysis and cross-

integra
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[ Microsoft Excel - Integra.xls.
{E] He Edt Vew Insert Fomat Took Data Window

INEHRIGRIVE LRSI

tabulation of data within an Excel spreadsheet

enabling a user to create multidimensional data views
by dragging and dropping column headings to move

data around.

A pivot table is an excellent reporting tool that sorts
and sums independently of the original data layout in
the spreadsheet. The example shown at the bottom
half of the screenshot alongside shows a summary of
exported data contained in the Data worksheet shown
with a unique list of companies down the rows and
work types along the columns

Integra for Notes, through its usage of Excel, is able to

1
M ota
BBDH GmbH
phical D
oration

Simisi Computer Solutions 18.42
Zulu Business Senices
otal Duration:

EREEEEEEE!

Work Type &3
Development MaillTracking  Meetings _ Phone Calls _Researcl
1.67 117 2.00

033 7.50 6.00
542 233 16.92 047

475 092
047

183
3.83 017
21.42 2347

allow users to select the creation of Excel PivotTables
related to a particular report being run.

While the use of a Pivot Table can be defined in the Integ
the Runtime Sorting and Grouping dialog by the end user

<45 i\ Data By Company { By Viork Type / 8y person / < 51
Ready NUM

ra profile itself, a profile which allows the use of
also allows a Pivot Table to be created simply

by the use of a single checkbox found in the runtime Sorting & Grouping dialog circled in the screenshot

alongside.

This facility requires that sorting and grouping has been enabled to at least 2 levels. In the case of the
example shown, the data would be grouped by Company and then by Work Type.

When creating the Excel spreadsheet, Integra will automatically generate a second worksheet within the

spreadsheet containing a Pivot Table with the field used f

or the first sort level set for the rows and the

second sorting field set for the columns. Once the template is created, further touching up of the

PivotTable including greater depth of analysis

would be perfectly possible. 9 integra

If the Generate Pivot Table option is selected, ‘ ] T
the user will also be able to set a value for the Sortby Order Group 3]
Pivot Table Page Header field and the Pivot [COMPANYNANE [l secina it Descending =
Table will add the selected field to the [workcrvee 7] @ Ascenang " pescenaing ~
PivotTable header. This feature will allow a | <] © Ascendng © Descending -
user to select a value from this field and only

display data meeting that filter condition. As an Croup by, o A8 fupchion o

example, if the field called Project was set for B S L i

the Pivot Table Header, then a list of available A1, DURATION 2
projects will be shown and, if one particular [woRKTYPE jsm Ry ) sreroe 2
project is selected, then only the data related to 7] DURATION -

that project will be displayed of course still | B 2l El
showing the companies down the rows and the

work types across the columns. If you are not
familiar with PivotTables in Microsoft Excel, we
recommend you access Excel’s help resources

Pivol

ata ' below data

™ Add Chart

able Fitter Selection (Page Header) j
based on:

related to this subject.

Integra for Notes 4.7 — End-User Manual V4.7/1.0
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2.2.2.2 Charting

If the Generate Pivot Table option has been
selected (see section 2.2.2.1), it is also possible
to generate a default chart related to the data
shown in the Pivot Table. The chart will be
generated in a separate worksheet and will use
the chart type defined as the default chart for
your Excel settings.

To enable the creation of a chart select the Add
Chart checkbox shown in the Runtime Sorting &
Grouping dialog and circled in the screenshot
shown alongside.

integra

for notes

2.3

Filtering Dialog

integra
6 quick repaorts Sorting & Grouping
Sort by Order Group Pﬁ
|C0r.|PANYNAME j ¥ Ascending { Descending W
|WOHI€I’YPE j ¥ Ascending { Descending W
| j ¥ Ascending { Descending r
Group by Function Add function to
|CU MPANYNAKNE | Sum j STAFFNAME Fs
DATEIOB
| DURATION x
|W ORKTYPE |Sum ﬂ STAFFNAME P
DATEJOB
| DURATION -
Place grouping {" above data  below data
W Generate Pivot Table
Pivot Table Fiter Selection (Page Header) ﬂ
based on:

The Data Filtering step of the Runtime Sorting &

Grouping dialog allows the user to report only on data which meets particular conditions which can be set
by the end user at runtime. This step allows easy selection of the data conditions using a user interface
similar to the setting of rules in the Lotus Notes mail file.

<@

lower level of performance.

Integra utilizes the full-text index of a database to optimize the performance of the
data filtering and databases which have a full-text index will exhibit significantly
higher levels of performance when using a Report which has filtering conditions set.
Databases which do not have a full-text index will still function correctly but with a

The Filtering dialog visually consists of four main areas:

Stored Filters — this allows predefined
filters to be created by a designer/super-
user and made available to end users for
easy usage.

Conditions - The condition setting section
which consists of drop down menus to
select the field(s) for condition setting, the
actual condition itself (i.e. contains, does
not contain, is between etc.) and the
values to be used for the condition

The generated Filter Condition — this is
where the condition created using the
dropdown menus is stored in the special
Lotus Notes syntax. Advanced users
already familiar with Notes’ search query
language are able to directly enter the
condition if they prefer.

in the view or all the documents in the view.

@integra

Step 3 of 4
Data Filtering

Stored Filter: [ T
Distance ig greater than 10km
Field Company is Cyberdev P\ﬁ
Project Name - Pay Tracker
| = |
" AND ©© OR
=S Use 7 to represent 3 single letter
Add fitter condition Us= * to represent 3 two or more letters.
Use , (comma) to separate multiple values
Fitter conditions: I}g

Run on: ©* Selected Documents In Active View Al Documents In View

Iﬂ@@@ OOOG’I

Run On — allows determination of whether the condition is applied to all documents currently selected
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2.3.1 Using Stored Filters
Stored filters are a number of prepared filter settings, usually prepared by a developer, that can contain
even complex data selection criteria that are then able to be utilized on an ad-hoc basis by end-users.
Stored filters allow the complexity of complex selection criteria to be hidden away from the end-user.
Stored Filters are created by a designer using e integ ra stepors
the Integra for Notes Designer Edition software qulckiiepoits Data Filtering
and are linked to a specific database or template
in the same way that an Integra profile is linked. Stored Fitter: D_t I | eooy
Field Ce v n ]}g
When positioned in the Data Filtering step the | i RS |
user is able to click on the dropdown arrow to € anp € oR
select from one of the available stored filters. Add fler conditon Uia* o pr s e
Filters are able to be given descriptive names to | | . ... mn—
ensure that the end-user is able to select the
correct filter.
On Selectlon Of the requ”,ed StOfed Flltel’, It |S Run on: * Selected Documents In Active View Al Documents In View
important forlthe end-user. to click on the Apply 0060 OO0 OO
button to action the selection.
e Integ ra Step 3of4 |}
qulck reparts Data Filtering
Stored Filter: |Distanc:e is greater than 10km
Field Condition Value
| =l =)
" anD ¢ OR
. \ Use 7 to represent a single letter
Having selected and applied the Stored Filter, the command for the filter will be shown in the Filter
Conditions block and a list of the Stored Filters added are shown below this box as shown in the
screenshot below.
Integra allows multiple Stored Filters to be .
applied accumulating the conditions set in e !ntkegpra Step 3o 4
each. If for instance one of the Stored Filters Resin
limits selection to clients where their -
Region=North and another filter limits the sorearier: | =l s |
selection to work sheets which involved bex Conebon e =
travelling in excess of 10 KM, then the 1 = = | |
application of both filters will utilize a (LA o8 T
combination of these conditions. | Use 0 represent 2 0 or o s
jse , (comma) to separate multiple values
. . ) i Fitter cundrtinns:P\E
In addition, if a Stored Filter has been applled FIELD DISTANCE = 10 AND FIELD PROJECT CONTAINS "Pay Tracker”
and then the other filtering methods used (see
section 2.3.2), the net effect is a combination _ — — — _
e Filter conditions added: Distance iz greater than 10km; Distance iz greater than 10km; Project
Of a" the COﬂdItIOI’]S Name - Pay Tracker
| Runon: % Selected Documents In Active View Al Documents In View
(1R N ) QOO
Integra for Notes 4.7 — End-User Manual V4.7/1.0 9

Shireburn Software Ltd - © 2009 — 5" January 2009




2.3.2 Setting Filter Conditions
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Multiple filter conditions are able to be set in the Runtime Sorting & Grouping dialog combining, for
instance, a date range with the value for a specific client account, member of staff or sales region.
Multiple conditions can be combined using the AND or OR option contained in the wizard and each time a
part of the condition is completed, the user is to click on the Add Condition button.

To set each filter condition:

Select field - click on the arrow in
the field drop-down menu button.
This will present the user with the
list of the fields/columns which are
being reported upon. Select the
field to be used for the condition.

Select the condition — select the
parameter to be used for the
condition. The list of available
conditions includes contains, does
not contain, Is equal to, Is not equal
to etc.

Enter the value — enter the value
of the condition. For instance, if
used with the condition contains,
the value may be Joe Doe. If used
with the condition is between, then
two data box values will appear
and the user can enter the value. If

@ integra

Step 3 of 4
Data Filtering

Stored Filter:

ﬂ Apply

Field Condition Value B
[DuRaTION || oreaterthan | |3| |
{" AND T OR
= Use 7 to represent 3 single letber
GAATIETIET T Us= * to represent 3 rm’or more letters
Use , (comma) to separate multiple values
Fiter conditions: I.\a

Run on: * Selected Documents In Active View Al Documents In View

IIQ@E)@ OOGG’)I

the condition is set on a date field, then two dates are expected. There is no need to surround values
with quotation marks. Just enter the value in the date format of your computer.

¥

F e The Integra Runtime Sorting & Grouping dialog is unable to validate the data
being entered. If a condition is set on a date field, the user must ensure that
the value or values entered are in fact dates entered in the date format used
on the user’s workstation. Invalid values will not be rejected by the wizard.

As indicated in the dialog box itself, can be used in values utilized for conditions.

Usea ?to

represent a single letter. Use a * to represent 2 or more letters. Multiple values can be separated by

a comma.

Click on Add Condition button - Once the condition has been set, click on the

Add Condition button. This will convert the condition entered into a Lotus

Add fiter condition

Note’s query statement which will be shown in the Filter Conditions box. In the event that a single
condition is entered and the user omits to click on the Add Condition button and proceeds to the next
step in the dialog, Integra will automatically add the filter condition before proceeding.
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2.3.3 Selection of data set on which to apply condition

An option also exists which determines whether the
filter condition applied will operate on only the
documents which have already been selected in the
view by the user or upon all the documents in the
database.

This option is indicated by a radio button selection in
the Runs On selection.

2.4 Prompt User Dialog

integra
e I g Step 3 ofd
quick reports Data Filtering
Stored Filter: [ | Apply
Field Condition Value By
& anD © OR
Use ? to represent 3 single letter
Add fiter condtion Us= " to reprasant 3 two or more lettars
Use . {comma) to separate multiple values
Fitter condtions: Pﬁ
FIELD DURATION > 3
@(-‘ Selected Documents In Active View ¢ All Documents |®

IO@@G 0000'

Depending on the choices set in an Integra Profile, when a profile is run, the profile may either
automatically run and export or import the required data, usually presenting the data in Excel, Word or
Acrobat, or the user may be presented with the Prompt User dialog box, allowing the user to make

choices at runtime that influence how the report is distribu

ted. The setting of the profile that controls this

is the Integra Action setting which should be set to Prompt User to ensure that the Prompt User dialog

box is presented at runtime.

The contents of the Prompt User dialog box will vary depending upon:

The profile type selected. Word profiles have
different properties to Excel profiles, which are in
turn different to Text/XML profiles. See an example
Word profile alongside.

The options set in the Profile

Whether the profile is for importing or exporting of
data.

Whether or not this dialog box is even presented to the
user, is a function of the properties of the selected
profile. The dialog box is only presented in respect of
Word and Excel profiles which have been set to Prompt
User (see later explanation). No dialog box is

presented to the user for Text/XML file profiles.

This section of the manual will describe the various
available options of this prompt User dialog box.
Samples of the Word and the Excel dialog boxes are
shown below. It will be noted that there is almost no
difference between the two profiles apart from the
Protection section which offers different choices based
on the different protection functionality available within
Word and Excel.

for notes
Document Title: ‘Time Sheets Statement - Prompt User
Run on @ Client " Server
Integra Action: Activate i
Notes Action: I SendTo
Open / Save As POF: Mo =
Protection: Mone -
Password: ‘ |
for notes
Document Title: |iTime Sheets Prompt User
Run on & Clent  Server
Integra Action: =T
Notes Action: [T SendTo " Save As Document
Open / Save As PDF: No =
Protection [” Contents " Scenarios
" Drawing Objects [~ Ul Only
Password | |

—.

Sample Dialog Box for Excel Profile
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2.4.1 Document Title

The document title displays the title of the document as defined within the profile. The same title appears
in the list box of available profiles and is designed to assist the user in identifying the profile.

2.4.2 Integra Action

The Integra Action field provides selection of the Word or Excel processes to be launched by Integra and
determines what occurs after the data is pushed to Word or Excel. The available options are:

Activate - Integra will activate the Word or Excel application

and bring Word or Excel and the created !pF?QIra f
document/spreadsheet active on the screen. This action _  _
allows the user to check and amend the created document ProumeriTes: [TmeSnects Stement-Prones e 4
before printing, sending or saving it back to Notes as well as Fumom © Gl [ sener ;
to have access to all the functionality of the products o et | 7
(assuming the protection settings allow this — see below). XA SaveTorie }
Save To File - This action will save the document straight A
into a file on your file system. If the filename has been Frotecton Hone El f
predefined within the profile, Integra will save the exported Passward | P
file using this filename. If no filename has been specified, the )
user will be prompted with the standard Windows File Save et SN S S G SV
dialog box.

Print/Preview - This action is similar to the Activate action in that Word or Excel will be brought up on
screen with the created document/spreadsheet, however, it will be automatically activated in Print

Preview mode. The user will still be able to amend and work with Word or Excel once they exit from
Preview mode.

Print - This action will send the Word document or Excel spreadsheet directly to the printer. You will
be prompted with the standard Word or Excel print dialog box for selection of various options.

None — When this option is selected, no Integra action will be executed. This option is only useful in
conjunction with one of the Notes actions. E.g., you may want to email an exported Word document
or Excel spreadsheet directly without any of the other Integra actions.

2.4.3 Notes Action

The Notes Action field allows definition of the specific Notes-related actions available to the user at the
time of running the Integra profile. The options available to the user depend upon the settings of the
selected profile and this option may not even be presented to the user within the dialog box. The two
available options, any and all of which may be disabled, consist of the following two options:

Send To — enables the sending of the generated Word document or Excel spreadsheet via email in
accordance with the Send To settings of the profile.

Save As — enables the writing back of the Word document or Excel spreadsheet to a Notes
document in the current or a different Notes database.

These options are further defined below:

2.4.3.1 Send To

This action will send the created Word document, Excel spreadsheet or Text file as an attachment within
an email message. The address to which the profile is to be sent (To, cc and bcc) and the Subject field
will be taken from the definition held within the profile. Setting these options is further described in the
Integra for Notes Designer’s Manual. (Creating Integra Profiles — The Notes Tab — Send To).
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An Integra profile which has the Send To option enabled, will have an option set which determines how
the mailing function is to operate. The available options are:

Immediate — this will send out the created Word or Excel document to the addresses immediately
with no opportunity for the user to confirm or change the e-mail addresses to whom it is to be sent.

Confirm — this option will display the Integra Iotegrofor Nokes - Ml Send Dialog
Mail Send dialog box to the user with the integra
address details as defined in the profile already fornetes
set. This will allow the user to confirm, modify,
remove or add e-mail addresses to whom the

file is to be sent. ;C IJ“”"”“@””“ com, =

Memo - this option will attach the created ECCH [
Word Or EXCG' file into a neW Memo form taken ;2:&“ :;::hi:e::a::i:me monthly time sheets report covering our project. Please feel
from the current user’s mail file. This extends flextonly) ez o call me (o discuss .

all the capabilities of the user’s mail file such as Regus

Delivery Options, Encryption, Signing, Return

Receipts etc, enables the user to store the file a0
in a folder and utilize any custom features built
into the user’s mail file. The Outgoing mail is

also stored in the mail file’'s Sent folder.

If the Send To option is used in a Word profile of type mail merge in conjunction with the Word actions
Activate or Print/Preview then Integra will send an email with a Word file attachment per selected Notes
document. After all Notes documents have been processed, the single sent Word documents will be
collected and activated as one Word document (separated with page breaks) in the Word Print/Preview
mode. The Word action Activate will be ignored in this case, as the single Word documents have been
sent prior to activating Word, hence Integra is blocking the possibility of the user modifying the documents
after they have been sent.

In the case of a Word export profile which has its Word Action set to

d MailMerge, only the Immediate option will be available for sending e-mails.
This is as MailMerge profiles are typically sent to multiple addresses, it is
impractical to allow user entry or confirmation of the e-mail address for
each addressee in turn.

2.4.3.2 Save As...
Integra provides the facility for Word, Excel, PDF and Text/XML files created through a profile to be
written back into a Notes document within the current or another Notes database. The profile would allow
identification of the method to be used for the writing back, the form to be used etc. This is further
described in the Integra for Notes Designer’s Manual. The only setting involving the user is his selection
of the Save As option in the Integra dialog box. If this is selected, then the document will be written back
in accordance with the settings as defined within the profile while if it is not selected, the data will not be
written back.

2.4.4 Save as PDF

By selecting either the Before Launch or After Launch PDF options, the user is able to automate the
process of converting their Word or Excel document directly to a PDF file. This option presupposes that
the Configuration document of the Integra database has been set to enable PDF output and that the
workstation from which the PDF conversion is being effected has either one of the supported PDF
creation solutions such as IntegraPDF configured.
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2.4.41 Before Launch
When the Integra Action is set to activate, normally the Word or Excel document will be presented on
screen. By setting the PDF option to Before Launch, instead of the Word or Excel document being
presented on screen, a PDF file will be presented. This ensures that the user does not tamper with the
data.

2.4.4.2 After Launch
The business need may require that the user is presented with a Word or Excel document which he is
then able to modify or complete. An example could be a quotation. In this case, by setting the PDF
option to After Launch, the user is able to complete the Word or Excel document and after closing either
application Integra will convert the document to a PDF file. It will then be this PDF file which is e-mailed
stored in a Notes document or saved to the file system.

2.4.5 Protection

If a user is converting Notes data into a Word document or Excel spreadsheet, a requirement may arise
to restrict the ability of the recipient of the reported data from modifying the data and claiming that that
was the data generated by Integra.

The protection options available in a Word profile are different to those available in an Excel profile as the
underlying applications offer different functionality. The following sections define the available functionality

in each case.
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2.4.5.1 Protection of Word Documents
Word provides different levels of protection within documents and Integra provides three options within
the Protection field.
None - The Word Document remains unprotected integra
and the entire document can be altered. for nStes
Allow Comments Only - The user can only add Cocument Tie [Fme S iatment - ror Use
comments to the Word Document. Comments are not Run o @ Cient C server
visible on the document (except for the marker which e fawae ]
indicates a comment to the user) and are not printed. Noles Acton I SendTo
This option delivers the highest level of protection. I [ =
Allow Revisions Only - The user can alter the e o e
document content, but the changes will be clearly Faasert s oS o |
indicated with different color and font properties. Text He TSmO
parts deleted by the user are not removed but 000
stricken out (stricker-out). e ==l
Allow Field-Editing Only - The user can only alter
the contents of the fields contained within the document.
When the profile has been defined in such a manner as to "Prompt User", the user will be prompted at
runtime for the Protection option using the default setting for protection as defined within the profile. The
user can overwrite the default if the profile is set to Prompt User.
If any one of the above options (except "None") is selected at runtime, the user is also prompted to enter
a protection password in the Password field defined below.
2.4.5.2 Protection of Excel Spreadsheets

Excel provides four different levels of protection within spreadsheets. Multiple protection schemes can be
selected and therefore the user is presented with a set of Checkboxes. The facility exists not to select any

of the protection options.
The available options provide the protection outlined below:

Contents - All data cells in the Excel spreadsheet are
protected against editing.

Drawing Objects - This option will protect all objects
from being moved or resized (such as textboxes,
pictures, charts,...).

Scenarios - This option will protect scenarios
(forecasts) from being modified

Ul Only - If you select this option then the entire
spreadsheet is protected, with the exception of
macros.

When the profile has been defined in such a manner as

integra

for notes

Document Title: ”Tima Shests Report

Run on: @ Client  Server

Activate e

" SendTo

Integra Action

Notes Action:

Open / Save As PDF: o =

Protection. I~ Contents ™ Scenarios

I~ Drawing Objects [~ Ul Only

Password ‘

LURY LY.

to "Prompt User", the user will be prompted at runtime for the Protection option using the default setting
for protection as defined within the profile. The user can overwrite the default if the profile is set to Prompt

User.

If any one of the above options (except "None") is selected at runtime, the user is also prompted to enter

a protection password in the Password field defined below.
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2.4.6 Password

This field is only available when the user selects one of the Protection options outlined above. The user
will be prompted to enter a password. Integra will create a random password as a default. The minimum
password length is 5 characters.

If one of the security options is selected in conjunction with any of the Notes Action options, Integra will
create a random password hidden from the user. This combination of options would usually be chosen
when creating documents (e.g. reports) where neither the user nor an eventual recipient of an electronic
copy of the document is allowed to alter the document.

protection against the casual user. Many software programs are available

IE Password protection in MS-Word and MS-Excel only offers an element of
across the Internet which will crack these passwords.

2.5 Runtime Foreigh Language Support

Integra for Notes supports the presentation of runtime messages, dialogs and error messages in various
languages, namely English, German, French, Italian and Spanish. In addition, Integra exposes these
messages to the user so any unsupported language can be translated by the user. These messages are
accessible through the Messages tab of the Configuration document.

When running Integra profiles, either through the Notes client or a supported web browser, all runtime
messages, dialog boxes and error messages will appear in either English, French, German, Spanish or
Italian depending on the language settings of the Notes client or browser.

When being used through a web browser, Integra will display messages in the appropriate language
based upon the language options set in the web browser.

) Integra 4.5 Demo - (All Profiles) - IBM Lotus Notes

File Edit View Create Tools  Window Help
% Hol = o Administration 3
Workstation Options B Install Integra Smartlcon

(=} fr=]
o th D2 HEE , Install Integra PDF Writer

Mew Profile...

When being used through a Lotus Notes client, the
choice of language will be based upon the
Language Preference option set within the Integra
database on a user by user basis. Setting of this
preference is made through the Preferences option.
This is accessible through the Actions 2Workstation
Options >Preferences menu option when

Preferences

Arial Settings... ,
- cpair/ Upgrade ProfleSelec (
m SIS N '\’j

positioned within the Integra database. JnteqifobiotecilegRistomnces E

integra
This selection will present the user with the for notes
following Preferences dialog box where there e e
. . . . icnable Loggin reguires the connguration ot an Integra Lo alabase g
is the Language Preference field. This field [ Enails Procres Bor A AEed !
allows selection of either of the supported I Enable Caching for Quick Reports
languages or selection of the NOteS Language preference for run-time messages:
Preference option. This last option will utilize [Notos Proforence =]
the language options which are set for the
user’s Lotus Notes language preference. ki e e

|UTF-16 - 16 bit platform native byte order encoding of ISO-10646.  ~|
O
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Setting the Lotus Notes Language Preferences is undertaken in a mnner which varies according to the
Lotus Notes versionin use.

To set the Lotus Notes Language Preferences in versions of Lotus Notes prior to Notes 8, select the
File >Preferences 2User Preferences menu option. This will open a dialog box in which the user should
select the International option and select the Regional Profile.

User Preferences m

& Basics

N Regional profile includes options thioughout the Intemational tab
@ = Intemational R B &

Gonaial Regional profile | Flesel Profe to Defauls |
‘Spell Check |
Calendar Change | Contentlanguage  [French
Bi-directional Change | Sorting [Uses -
[ B Mail Changs | Altemate name language [French
9 Ports Change | Import/Export characters  [western Ewnpean and US [windows)

&  Replication

Unit of measurement
" Inches
&+ Centimeters

To set the Lotus Notes Language Preferences in versions of Lotus Notes 8, select the File>Preferences
menu option. This will open a dialog box in which the user should select the Regional Settings option and
then select the Regional Profile drop down menu.

-
Inir) Preferences -
type filter text Regional Settings
Accounts I i {
Basic Motes Client Configurz Aregional profi TFazset the selected profile to its
Calendar and Te Do Rl
Composite Application Editc Regio E—
Contacts
Feeds Language settings for Engia 1 '
Fonts -
Content language: English Chi - :
Home Portal Account ) ‘ = ﬂl
IBM Lotus Symphony S |- Use 05 - Change
Live Text Altemate name language {Engﬁgh Change...
Locati
Lz;asleot;;gs Import/Export characters:  Westem European and US (Windows) m (
Mail
Notes Ports 1~ Measurement settings for English - )
Regional Settings Unit of measurement: o
Replication " Inches (
Sametime * Centimeters b
Search ' /
Pl ™ vﬂ,“\"““‘- st -AL"""" - #' . ‘kv"‘*“*\r

From the next use, the Integra runtime message boxes will appear in the chosen language. Choosing
any unsupported regional settings will result in Integra operating in English.
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3 Running Integra Profiles from a Web Browser
Integra for Notes supports the running of Integra export profiles from a supported web browser. No
support is currently available for web browser based importing, although imports can be run on a
scheduled basis.
A web browser cannot be used to create or modify Integra profiles as this functionality requires the use of
facilities available only in the Notes client.
While running Integra from a Notes client allows selection of an Integra Smarticon, this O
functionality is not possible within a browser and therefore the triggering of an Integra profile can
only be effected by adding an action button, button or hotspot within the application being called by the
browser.
The section of the Integra Designer’s Manual entitled Preparing a Database for Integra Web Access,
describes the exact changes that need to be effected to a Notes database to enable it for Integra web
access. This section describes the user experience in running an Integra profile through a web browser.
As also defined in section 8, the action button or hotspot can be set either to launch the Integra Profile
Dialog Box or alternatively it can be set to execute a specific named profile.
For the purposes of this section, we shall assume that the Integra profile or Profile dialog box are being
launched from an Action Button however all these instructions are equally relevant to the running of
Integra profiles from a graphical hotspot or a standard button.
This section will not describe the process through which a browser is used to access a Domino database.
An assumption is made that this process is already clear to users and it is specifically the use of Integra in
this context that will be described.
The user interface for running Integra profiles via a Notes client or a Web Browser has been intentionally
kept as similar as possible and this section will therefore not repeat the functionality of each of the similar
options.
3.1 The Integra Profile Dialog Box
On Se|eCti0n Of an aCtiOﬂ bUttOﬂ WhiCh |aUﬂCheS @ http://quartz - Integra for Notes - Profile List Dialog for Integra TS Dema WEB lElili—hJ
the Integra Profile Dialog box, the user will be ]
presented with the following screen showing all Integra
the Integra profile available and linked to the —
current Notes database. You will notice that this TS
is the same dialog box as presented to the Notes Test
user client.
I
9000
Done S o |
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On selecting the desired profile, Integra will access the data from the Domino server during which a
“processing status” window will be presented to the user. Integra will then push the requested data into
the Word document or Excel spreadsheet.

@ http://quartz - Integra for NDtes...I.Elﬂlﬂ_hJ

| Done ¥
% T R . 1 o

l

Depending on the settings of this option, the user may be presented with a confirmation dialog allowing
the user to select whether they wish to Open or Save the generated document.

File Download x|

< Some files can harm vour computer. I the file information below
\.‘/ looks suspicious, or you do not fully trust the source, do not open or
save thiz file.
File name: ...raWwordDocument_1609140.doc
File type:  Microsoft Word Document

From: pearl

‘Wwiould wou like to open the file ar save it to your computer?

[ Open ] [ Save ] [ Cancel ] [ More Info

Alwayz azk before opening this type of file

Note that the Always ask before opening this type of file option is available. Turning this option off will
automatically Open or Save when accessing either a Word or an Excel file.

It is therefore possible for the user to select the check box to determine that this dialog box is not
presented to the user each time.

Selecting the Save option will result in the user being presented with the standard Windows dialog box
where a file name and path can be

/3 http:#pearisoftitest/integrafintegraweb. nsfiWeb%20Activity%20Monitor/2DC1 F85393BSIECCCT 256CB6 - Microsoft Intern... [2|[E)[K]

selected and into which Integra will then e T T o o
save the generated file. On Deat - @ X B @] Dseweh Foreontr @rese @ [ - 1 F L
Successfu”y Saving the file, control will adress (@] et 20actvy L sasectunosate T | E] @0 s B
return to the browser window focused L -TNEEERE SREEENKE KEKE KNAY AEXNARRS AXEREREE CRERRRRX AREFARRE ARKNRF- (12
on the Notes database.
In the event that the Open option is i B e e 7
selected, the user will next be presented |: | o= fmeesen e B
with the browser window containing the |- V””
Word document or Excel spreadsheet. i e s R o e D) Cr T
] A ddress Luger House i Fax f i
See the screenshot of a Word document |- Dk e (easal
alongside and an Excel example MSTO?
| f % Zﬁi:?y ﬁrk;: h?:r:‘glx/:‘:n"::nd Titserior Tl Eir) -
overiear. . Wddress 10, Triq il Marbat Chan FEg5h £
il Swieqi FEMal | st ke mmnet et mt o
STI02 T
EEEERD 3
&) C Unknowin Zone
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3.1.1

B3 Microsoft Excel - IntegraExcelSheet E]@E|
Fle Edit View Insert Format Tools Data Window Help -8 X
DeEa gRY - (1 NE =
Arial -1 . Hod-A -
A1 - a3
Indicates editable Z
cells and on-line
help to the cells or
action icons. SHIREBURN
_J‘/ Carclina Court, Guze Cali Street
Ta' Mbiex, MSD 14, Malta
Tel +356 2131 9977
AE&F Inc Fax +356 2131 9528
22 Arnerican Street infogshireburn corm
Morth Carolina, 28120 wwrwy shirebum com
USA
Atz ir. Doug M Fry
Our VAT No: 10170107 °
Cluotation Ref. -
Date: 12/05/2003 7
QUOTATION
Oty ;Descripti USH Total
0.00
0.00
0.00
0.00
0.00
0.00
2 Sub-total (US§) 0.00 =
W 4 » niSheetl / |4l [

Example of an Excel quotation spreadsheet
generated by Integra through a web browser.

Running an Individual Profile

integra

for notes

At this point, the user has the ability to utilize all the facilities available to the browser such as printing,
mail sending etc.

Integra for Notes allows the creation of an action button, hotspot or button in a Notes view or form which,
when triggered by the user, will launch a specifically named Integra profile. This option removes the
Integra Profile dialog box which lists all the profiles and allows selection of a specific profile.

Section 8.2 of the Integra Designer’s Manual outlines the requirements and coding of this type of button.

When executing an action button that runs a specific profile, the process and procedure is exactly the

same as that related to selecting a profile from the Profiles dialog box and the same options and screens
are presented to the user.
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References

Additional assistance is available to users as listed below:

User manuals www.integra4notes.com/manuals
On-Line Demonstrations www.integra4notes.com/demo
FAQ’s www.integra4notes.com/faq
Support www.integra4notes.com/support
Available Training www.integra4notes.com/training
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